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Introduction

FrameMaker® document processing software turns your
workstation into a powerful document authoring and publishing
system. With FrameMaker you can create technical documents,
presentation materials, newsletters, and other types of

documents, incorporating text and graphics freely on the page.
FrameMaker provides extremely powerful word processing,
drawing, and document and page layout features in one integrated

program.

Using this manual

FrameMaker User’s Manual

This manual teaches you how to use FrameMaker’s basic
capabilities:
Chapter 2 You set up your training environment,

start and quit FrameMaker, open a
FrameMaker document, and do basic text

entry.
Chapters 3 through 6  You learn how to edit and format text.

Chapter 7 You use FrameMaker’s drawing and
alignment tools to create graphics.

Chapter 8 You add graphics to your document.

Chapter 9 You create a custom page layout for your
document.

Chapter 10 You find out where to look for more

information about FrameMaker features.

You’ll need between 15 minutes and 1 hour to complete each
chapter of this manual. We recommend that you finish a chapter in



Finding more information Chapter 1. Introduction

one sitting, since the instructions assume that you are doing so.
Feel free, however, to take a break between chapters whenever
you need one. You can even work on this tutorial over a period of
days or weeks.

Finding more information

For on-line information about FrameMaker, use the Help
command. For more information about the Help command, see
Getting help in Chapter 2 of this manual or see the Help command
in Chapter 3 of the FrameMaker Reference Manual. The
FrameMaker Reference Manual also contains a complete
description of FrameMaker concepts, features, and commands.
For instructions on installing FrameMaker, see the installation
instructions in your FrameMaker Software Release Notice .

This manual assumes that you are already familiar with your
workstation and its window system. If not, refer to the
documentation you received with your workstation.

2 FrameMaker User’s Manual
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This chapter contains important information that you’ll need as
you read this manual. You’ll learn how to:

[

L]

Interpret the fonts (the different typefaces and typestyles) and
terminology in this manual.

Set up your training files.

Start FrameMaker.

Use FrameMaker templates.

Use FrameMaker commands and dialog boxes.
Type text in a document.

Change the tag and format of a paragraph.
Correct typos.

Insert, delete, and replace text.

Save and quit a document.

Quit FrameMaker.

This manual is written with the assumption that a licensed copy of
FrameMaker has been installed on your system using the
procedures described in the installation instructions in your
FrameMaker Software Release Notice . Please refer to those
instructions or see your system administrator if you need help
installing FrameMaker.
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Understanding terminology

When we refer to a filename, directory name, or text that you see
in a shell window, we show that text in a typewriter font. For
example, we might say, “The error message No such file or
directory appears.”

When we refer to text that you see in a FrameMaker window, we
show that text in italics. For example, we might say, “Put the
insertion point in the heading that begins with Organization.”

When we want you to type some text or to press a key, we show
the text or key name in bold. For example:

When we say: We mean:

Type May 30 Type the characters exactly as shown,
including the space after the y in May.

Press Enter Press and release the Enter key.

We use the following terminology to describe how you use the

mouse.

When we say: We mean:

Point Move the tip of the mouse pointer onto
something on the screen. For example, we
might say, “Point in the name stripe.”

Click Press and release a mouse button in one
smooth motion. For example, we might say,
“Click the left mouse button.” If we don’t
tell you which button to click, you can click
any button.

Drag Move the mouse while holding down a

mouse button. For example, we might say,
“Press and hold down the left mouse button
and drag the mouse pointer 1" to the right.”

Finally, you will frequently use several keys on your keyboard for
keyboard shortcuts:

Esc key Labeled Esc on your keyboard. The Esc key
is indicated by an exclamation point (!) in
FrameMaker menus.

Cul key Labeled Ctrl.

Alt keys Labeled Alt.

4 FrameMaker User’s Manual
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Setting up your training files

Most keyboard commands involve pressing two or three keys,
either together or in succession.

When we say: We mean:

Press Escfc Press and release three keys in
succession: the Esc key, the
letter f, and the letter c.

Press Ctrl-e Press and hold down the Ctrl key
and then type the letter e.
Press Shift-Ctrl-e Press and hold down both the

Shift and Ctrl keys and then type
the letter e.

Setting up your training files

Ask your system administrator if your training environment has
been set up. If not, follow the instructions below.

To set up your training environment:

1. If you have not already done so, start your workstation and
your window system.

2. If you are using the U.S. version of FrameMaker, at the prompt
(ending with %, $, or #) in a shell window, type the command
fmsetuptraining and press Enter.

This command creates a new directory (fmtraining) in your home
directory and then copies several FrameMaker documents into the
new directory. If an error message (ending with

fmsteuptraining not found Or fmsetuptraining terminated
without completing) appears in the shell window, ask your
system administrator for assistance.

Starting FrameMaker

FrameMaker User’s Manual

To start FrameMaker:
1. Move the mouse pointer into a shell window.

2. If you are using the U.S. version of FrameMaker, type the
command maker at the prompt and press Enter.

3. If you are using the International version of FrameMaker, type
the command imaker at the prompt and press Enter.

4. If the arrow pointer changes to an icon representing a window,
move it to the position on the screen where you want the
FrameMaker Message window to appear and click the left
mouse button.



Getting help

Getting help
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Frame Maker opens the Message window and displays
messages in the window while it loads. Keep the Message
window visible while working, so you can see any messages
Frame Maker displays there.

After the program is loaded, the main FrameMaker window
appears in the upper-right corner of the screen.

NEW | OPEN |TOOLS| HELP | INFO | QUIT

Now you’re ready to use FrameMaker.

You use the Help command to display information about
FrameMaker on the screen.

To get help:
1. Point in the HELP box in the main FrameMaker window.

NEW | OPEN |[TOOLS| HELP | INFO | QUIT

\

. Click any mouse button.

After a few moments, the Help Index appears on the screen in
the Help window.

. Look through the Help Index to see what kind of help is

available.

To quit help:
1. Inthe Help window, point in the Quit Window button.

2. Click any mouse button.

The Help document is removed from the screen.

FrameMaker User’s Manual
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Using template documents

Using template documents

To make it easy for you to create your own documents, several
basic templates, which contain a preset page layout and paragraph
formats, are provided with FrameMaker, including:

FrameMaker User’s Manual

*

[

L ]

Letters

Memos

Viewgraphs

Technical documentation
Resumes

QOutlines

See your system administrator for information about other
templates that may have been added at your site.

To use a template:

1. Point in NEW in the main FrameMaker window.

NEW HELP | INFO

\

OPEN |TOOLS QUIT

2. Click any mouse button.

The New dialog box appears, with the insertion point (l) in the
Use Template edit box. The scroll list below the edit box
contains a list of directories that contain templates at your
site. If more templates have been added at your site, the
contents of your scroll list will be different from the scroll list
shown below.

New Document [ oK

Use Template:
= 1

Current Directory:

faiframe1.3XcHmtemplates
../ (Go up 1 directory level)
BasicTemplates? ]
BlankPaper/
OtherTemplates?
Templatelnstructions

Insertion point

Scroll list

4 Directories, 1 File
( Make a custom Document.... ]
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The document named TemplateInstructions (in the scroll
list) contains information on using the templates provided with

FrameMaker.

Use a special template

As arule, you’ll use one of the templates provided with
FrameMaker, or one of the templates added at your site, to create
a document. Since we can’t know how templates have been
customized for your site, however, you’ll use a special template in
this chapter to create the brief business note shown below:

January 26, 1988

John:

Qur meeting today raised some issues I'd like
to check. Who authorized shipment of the new
controller?

Where are the propulsion units we ordered
six months ago? Should we look for another sup-
plier? I'm worried that the development team is
going to “fall apart at the seams.”

Use the file browser to find the template we set up for you:

1. If there is a filename in the edit box, press Delete several

times to delete the filename.

2. Type the abbreviation for your home directory: ~

Click OK.

After a few moments, the contents of your home directory,
which will look different from the contents shown below,

appear in the scroll list.

New Document [ oK ][ Cancel ]

Use Template:

ol l

Current Directory:
tusrhome/eim

. (Goup 1 directory level)
Filtermans?

bin/

fmtraining/

int}

letters/

mail/

misc/

personal

planst

16 Directories, 18 Files

(Make a Custom Document... ]

FrameMaker User’s Manual
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Using template documents

If you don’t see the directory fmtraining in the scroll list, click
in the downward-pointing scroll arrow (in the lower-right
corner of the scroll list) to scroll the list until “fmtraining/”
appears in the list.

.4 {(Goup 1 directory level) i

Filtermans/ | «——— Drag the scroll box to scroll to
hin? i

{miraining! another part of the list.

intl?

letters/ <———— C(lick in the gray area to scroll
ma the list one windowful at a time.
personal! g B .

plans? 4] «— Click in a scroll arrow to scroll

16 Diractories, 18 Files the list line by line.

You can tell that fmtraining is a directory because
FrameMaker puts a slash (/) after the name.

Point on “fmtraining/” in the scroll list and click the mouse
button to highlight the entry.

“fmtraining” appears in the Use Template edit box.

New Document [ 0K ][ Cancel ]
Use Template:
[ fmtraining |

Click OK.

After a few moments, the Current Directory above the file
browser is updated, and the contents of the fmtraining
directory appear in the file browser. Notice that there’s a
templates directory in the scroll list.

Current Di : .
m?iﬁm"ﬁfn{%m Current directory

.4 (Goup 1 directory level)
templates?
Coverletter.doc

OrgChart.doc
Project3.doc
Projectd.doc
Projects.doc

Projecte.doc

Contents of the current directory

2 Directories. 11 Files

To look at the templates directory, double-click on
“templates/” in the scroll list. (This has the same effect as
clicking once on an entry in the scroll list and then clicking OK.)
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After a few moments, the contents of the templates directory
appear in the file browser.

¥ .4 (Go up 1 directory level)
Note

1 Directory, 1 File

8. To open a copy of the template, double-click on Note in the
scroll list.

After a moment, the FrameMaker document window appears.

Document Edit Fonmat TextRects Guides Page

<——Menu bar

|

Rulers

T

Insertion point (1 ) and
end-of-flow symbol (§)

Column border
outlining text
column

Window border

........................................................................

Depending on your window manager, your document window
may also have a name stripe. If it does, notice that the
document name is NoName. When you finish the note, you’ll
save it under another name.

10 FrameMaker User’s Manual



Chapter 2. Getting Started

Using menus

GUIDES
Grad
wCRulers

O Text Symbols

Units, ..

FrameMaker User’s Manual

Using menus

You create and manipulate documents in FrameMaker with
commands. You can access most FrameMaker commands easily
by using menus in the menu bar at the top of the document
window. To see what we mean, in the next exercise you’ll change
the units of the rulers at the top and left side of the document
window.

Change the ruler units

To change the ruler units, you choose the Units command from the
Guides menu:

1. Put the tip of the mouse pointer in the word Guides in the menu
bar at the top of the document window.

2. Press and hold down the right mouse button.
The Guides menu appears.

4. Drag the mouse pointer down until the Units command is
highlighted.

5. Release the mouse button.

The Units dialog box appears.
Ruler Divisions:  Grid Spacing: ( ok )
»Or O 2cm

O l:zr:m O1em
O 14acm O 12em Display Units:
O Fica Or Oaom

@ 18" (OR-Y @ Inch
Oner Oin O Fica
QOnz O O Point

Notes

The circles to the left of each setting form a kind of control that
you’ll see in many FrameMaker dialog boxes. They are called
radio burtons. You use the buttons to select one setting from a
list, the way you use the buttons in a car radio to choose a station.
Pressing a different button changes the radio station; pressing the
same button a second time has no effect.

You can use any mouse button to display the menus in the menu
bar at the top of the document window. But since you can display
other menus (explained later in this manual) only by using the
right mouse button, it’s a good idea to use the right mouse button
for all menus.

11
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Now, to change the ruler units:

1. Click on the button to the left of the “1/10"” setting to select
1/10" ruler divisions.

Notice that the black dot disappears from the button next to
“1/8" and moves to where you just clicked.

2. Click OK to make the new ruler divisions appear.

If you had wanted to leave the ruler divisions unchanged, you
would have clicked on Cancel.

After you display a menu, you can easily put it away without using
any of its commands. To do so, drag the mouse pointer outside the
menu (so that no command is highlighted) and then release the
mouse button.

Now you’re ready to type some text in your document. You should
still have the empty document window on your screen. If not,
please go back to Using template documents, earlier in this
chapter, and set up the window.

When you open a document, FrameMaker automatically puts the
insertion point (1 ) on page 1, followed immediately by the
end-of-flow symbol (§). Because the two symbols overlap ( b,
they may be difficult to distinguish on the screen.

The paragraph and end-of-flow symbols and the column border
won’t appear on the printed copies of documents. You can turn off
their display using commands in the Guides menu. We
recommend, however, that you leave them displayed; you’ll find it
easier to work with FrameMaker if you can see the structure of
your documents.

To type the text:

1. If you don’t see the insertion point in the document window,
point in the middle of the document window and click the
middle mouse button. Be sure to leave the pointer inside the
document window.

2. Type today’s date but don’t press the Enter key.

The date appears in the document window.

- Yaiiiary 26, 19Bg T
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Chapter 2. Getting Started

FORMAT

Tabs. ..
Fonts. ..
Paragraphs. ..
Catalog...

Auto Hyphenation...

Number of Columns...
Headers & Footers...
Freeze Pagination...

Repaginate...

Ift
Iff
Ifp
Ifc
!fa
Ifn
'fh
Ife
I fr

Typing text

Notes

The mouse pointer must always be inside a document window in
order for you to be able to type there.

FrameMaker User’s Manual

If you didn’t care about the format of the document, you could
continue typing the text of your note. Since you want the date to
appear further to the right on the page, however, you’ll need to
change the paragraph format for the line you just typed. One of the
advantages in using a template is that you can use the paragraph
formats stored in the template’s paragraph Catalog.

To display the paragraph Catalog, you choose the Catalog
command from the Format menu:

1. Put the tip of the mouse pointer in the word Formart in the
menu bar at the top of the document window.

2. Press and hold down the right mouse button.
The Format menu appears.

3. Drag the mouse pointer down until the Catalog command is
highlighted.

4. Release the mouse button.
The Catalog dialog box appears.

Catalog Apply to ok )
’ :;':3' @ Current Cancel
R —
Qau

(O update entire document
(O Delete from catalog

In the Catalog scroll list on the left side of the dialog box, three
tags appear: “body,” “date,” and “salutation.” Associated
with each tag is a paragraph format that we created for you.

In Chapters 3 through 6, you’ll learn how to change these formats
and how to add new formats to the paragraph Catalog. For now,
however, you’ll use the formats already in the Catalog.

To use a different format and tag for the paragraph you just typed:
1. In the Catalog scroll list, click on “date.”

The “date” tag is highlighted.
2. Click OK.

13
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The paragraph format (in this case, the indentation and
spacing) changes to match the “date” format stored in the
Catalog.

e Vaiiiay 26, 19085

Also, notice that the paragraph’s tag (shown in the bottom
border of the document window) is now ‘“date.”

Tag: date 10f1

To start a new paragraph:

1. Make sure that the insertion point is still at the end of the line
containing the date. If it isn’t, click the middle mouse button to
the right of the end-of-flow symbol.

2. Press Enter.

A paragraph symbol () appears to the right of the date, and
the insertion point moves down in the document window,
indicating that you have begun a new paragraph.

........................................ Ianua;[y 26’ 198 81[ .....
: E .

Notice that the new paragraph has the same format and tag (in the
bottom border of the document window) as the preceding
paragraph. This new paragraph will be the salutation. Even though
the date and the salutation are each one line, they are separate
paragraphs in FrameMaker and, in this case, need to be formatted
differently. For this paragraph, you’ll use the format stored in the
Catalog with the tag “salutation.”

To change the format and tag of the new paragraph:

1. Choose the Catalog command from the Format menu.

2. In the Catalog dialog box, click “salutation” in the scroll list.
3. Click OK.

The paragraph format (the indentation and spacing) changes
and “Tag: salutation” appears in the bottom border of the
document window.

e Taiiiiy 26,1986

\ The next paragraph
_QV . begins here.

To type the salutation:
1. Type John:

14 FrameMaker User’s Manual
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2. Press Enter.

Since the next paragraph is the beginning of the body of the note,
you need to change the paragraph format and tag again (this time
using the format stored in the Catalog with the name “body”).

To type the body of the note:
1. Use the Catalog command to change the format of the

paragraph using the tag “body.”

The tag and paragraph format change (the tag changes to
“body”; the first line of the paragraph is indented 1/4").

. Type the next paragraph of the note, as shown below:

Our meeting today raised some issues I'd like
to check. Who authorized shiprnent of the new !
ccontroller?§

As you type, don’t worry about where the lines end.
FrameMaker will automatically wrap the text from line to line
(and hyphenate words) as needed, keeping the text within the
text column (the column with the dotted border).

Type only one space between sentences. When you learned to
type, you may have learned to follow the end of a sentence
with two spaces instead of one. That works well when all
characters have the same width. When using FrameMaker,
however, your documents will usually look better if you type
only one space after each sentence.

If you make a typing mistake, press the Delete key (or the
Backspace key) to delete the error; then type in the correct
text.

. At the end of the paragraph, press Enter.

Since the next paragraph is also a body paragraph, you don’t
need to change the paragraph format.

. Type the last paragraph of the note, as shown below:

¢ Where are the propulsion units we ordered
isix months ago? Should we look for another sup- :
plier? I'm worried that the development team is !
igoing to "fall apart at the seams."§

15
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Shortcuts

In a menu, the keyboard shortcut that chooses the command

m appears to the right of the command (the “!” in the menu stands

Fonts Lff for the Esc key). These shortcuts are easy to remember, since the
Paragraphs. . . 1fp | two letters following Esc are usually the first letter of the menu
Catalog. .. Ifc name, followed by the first letter of the command. For example,
Auto Hyphenation... !fa | the keyboard shortcut for the Catalog command is Esc f ¢ (for
Number of Columns... !fn format menu, catalog command). If you like, try using these
Headers & Footers... !fh | = ghortcuts as you follow the instructions in this manual.

Freeze Pagination... Ifz

Repaginate. .. Lfr There are several other keyboard commands that you can use to

simplify tasks such as changing the tag of a paragraph. They allow
you to accomplish these tasks in a few keystrokes without moving
your hand back and forth between the keyboard and the mouse. In
Chapter 6, we’ll show you how to use keyboard commands to
change the tag of a paragraph without using the mouse.

For a complete list of keyboard shortcuts, see Appendix A of the
FrameMaker Reference Manual.

Editing text

Now that you have typed the text of your note, you can edit the
note.

Add text
To add text:

1. Point between the second r in controller and the question mark
that follows it (see below).

2. Click the middle mouse button to put the insertion point there.

The insertion point, indicating where text will appear when you
begin to type, appears to the left of the question mark.

:  Our meeting today raised some issues I’d like :
10 check. Who authorized shipment of the new  :

Econtro]lt{ﬂ

If the insertion point is in the wrong place, move the mouse
pointer and click again.

Insertion point

3. Press the space bar and then type in May

16 FrameMaker User’s Manual
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The new text appears.

:  Qur meeting today raised some issues 1'd like :
1o check. Who authorized shipment of the new
ccontroller in Mayj

To insert a new paragraph:

1. Point in (or to the right of) the end-of-flow symbol at the end
of the last paragraph in the note and click the middle mouse
button to put the ins€rtion point there.

:  Where are the propulsion units we ordered
six months ago? Should we look for another sup- :
plier? I'm worried that the development team is
‘going to "fall apart at the seams."§

A

Insertion point

2. Press Enter to start a new paragraph and type Thanks for
the information.

Change text

Next you’ll learn how to change text. In particular, you’ll replace
one kind of quotation mark with another.

Typewriters and many word processors offer one double quote
character (). FrameMaker offers three (" “ ”’). Use the standard
quote (") to indicate inches or when the text is in a typewriter
font. Use the left and right quote characters when you want to put
text in quotes. If you typed standard quotes (") in the note, follow
the instructions below to change them to left and right quotes.

To delete a character:

1. Put the insertion point at the end of the paragraph containing
the quote.

. Where are the propulsion units we ordered
six months ago? Should we look for another sup- :
plier? I'm worried that the development team is

‘going to "fall apart at the seams.'f

Insertion point
2. Press Delete or Backspace.

The quote character disappears.
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To type a right quote:

1. Press Alt-> Then, with that key held down, press the ’ key.)
The ’ key is to the left of the Enter key.

To replace the other standard quote with a left quote:

1. Put the insertion point to the right of the other standard quote.
2. Press Delete.

3. Press Alt-¢ (The  key is above the Tab key.)

Notes

FrameMaker offers two apostrophe characters (' and ’). In normal
text you’ll probably want to use the curved apostrophe.

Straight apostrophe 3 Curved apostrophe '
You shouldn't have done this. You should’ve done this.
Acceptable Better
To type a: Press:
Curved apostrophe (’) > (The ’ key is left of Enter.)
Straight apostrophe (') Ctrl-’ (The ’ key is left of Enter.)
Delete text

You have learned how to delete characters using the Delete and
Backspace keys. To delete a larger block of text, however, you
need a faster approach.

To delete text:

1. Point between the two sentences in the paragraph below the
salutation, as shown below:

: Our meeting today raised some issues I'd like :
1o check.Who authorized shipment of the new
§comroller‘§1 May?q

2. Press and hold down the middle mouse button and drag the
mouse pointer down and to the right. Notice how the
highlighting follows the pointer.
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3. When the entire sentence (but not the paragraph symbol) is
highlighted, release the mouse button.

Our meeting today raised some issues 1'd like :
cd Shipment or e new :

If the wrong text is highlighted, begin again with step 1 above.
4. Press Delete.
The sentence disappears.

Notes

If, after highlighting some text, you want to remove the
highlighting without deleting the text, click the middle mouse
button anywhere within the document window.

Replace text

You’ve learned how to add text and how to delete a block of text.
You can combine these two techniques into one continuous action.

To replace text:

1. Highlight the words propulsion units as shown below. Don’t
press Delete.

©  Where are the we ordered
six months ago? should we look for another sup—

pher'? I'm worried that the development teamis :
‘going to “fall apart at the seams.™ :

2. Type widgets

Notice that the highlighted words disappear as soon as you
type the first letter and that your new typing appears in its
place. All subsequent text moves along in front of the insertion
point.

:  Where are the widgets|we ordered six :
months ago? Should we look for another suppli- §
er° I’'m worried that the development team is go- :
mg to “fall apart at the seams.”q :
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Undo an action
If you accidentally delete or replace some text, use the Undo

Undo leu

cut Lo command to restore the deleted text:

Copy fec 1. Point on the Edit menu.

Paste lep .

X Paste et | 2. Pressand hold down the right mouse button.

Search. .. tes The Edit menu appears.

Markers. .. lem

Anchored Frame... 'ea | 3. Drag the mouse pointer down until the Undo command is
Spelling Checker... !el hlghhghted

4. Release the mouse button.

The text you replaced reappears.

Finishing up

You should save your work occasionally. If disaster strikes (in the
form of a power or system failure, for example), you will have lost
only the work done since the last time you saved.

Save your document

Since the document that you opened at the beginning of this
chapter was a template, you’ll save this document with a new
name.

To save the document:
1. Choose the Save command from the Document menu.

The Save dialog box appears, with the insertion point in the
Save in File Named edit box (your current directory, and the
contents of your scroll list, will look different from the one
shown below).

Save in File Named: (o )
»| NoName| ]

Current Directory:
fusrmome/elm

ol Format:

::::7 ns (@ Maker Format

fmtraining/ QO Text Only

int (O Maker Interchange Format
letters? Permissions:

mail? rmissions:

misc/ Group: [X]Read [ ]write
personal/ . i
plans? Public: [ Read [ ] write
16 Directories, 16 Files [X] Make a Backup File before Saving
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2. Delete the filename NoName (either by pressing Delete
several times or by pressing Ctrl-u once).

Pressing Ctrl-u deletes everything between the insertion point

and the beginning of the line.
3. Type~/ and click OK.

After a few moments, the contents of your home directory
appear in the scroll list.

4. Double-click on the “fmtraining/” entry in the scroll list.

After a few moments, the contents of your training directory
appear in the scroll list.

5. Click in the Save in File Named edit box and type
SampleNote.

6. Click OK to save your note in the fmtraining directory.

The mouse pointer turns into an hourglass as FrameMaker
saves your file.

Notes

Using the Save command, you can:

» Change the read and write permissions of your document.

+ Choose the format in which your document is to be saved. The
default is “Maker Format,” which is usually what you’ll want.

For more information, see the Save command in Chapter 3 of the
FrameMaker Reference Manual.

Quit your document
To quit your FrameMaker document:
1. Choose the Quit command from the Document menu.

The document window disappears from the desktop, and the
document is removed from your workstation’s memory.

Quit FrameMaker
To quit FrameMaker:
1. Click QUIT in the main FrameMaker window.

NEW | OPEN |TOOLS| HELP | INFO | QUIT
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If you haven’t made any changes since your last save,
FrameMaker will ask, OK to quit FrameMaker? If you wanted
to quit FrameMaker, you would click OK.

2. Since you’ll use FrameMaker again in Chapter 3, click Cancel.

Mouse button usage

By now you have used the mouse buttons in several ways.
Remember:

» To display FrameMaker menus, use the right button.

» To put the insertion point in text or to highlight a block of text,
use the middle button.

» To change dialog box settings, use any button.

As you’ll find out later, you use the left button to manipulate
graphics and other objects in a document.

Review

In this chapter you learned how to:

» Interpret the fonts and terminology in this manual.
» Set up your training files.

» Start FrameMaker.

* Use a template.

» Use FrameMaker commands and dialog boxes.
» Type text in a document.

» Change the tag and format of a paragraph.

» Correct typos.

« Insert, delete and replace text.

* Save and quit a document.

¢ Quit FrameMaker.

What’s next

In Chapter 3, you’ll learn how to scroll through a longer document
and do more complex text editing (moving and copying text within
and between files and searching for and replacing text). You’ll
also learn how to edit your documents using the keyboard rather
than the mouse.
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Now that you know how to create a document with FrameMaker,
it’s time to learn how to edit your text. In this chapter you’ll learn
how to:

* Move from page to page within the document.
» Copy and move text.

» Edit text without using the mouse.

» Search for and replace text.

* Quit a document without saving changes.

Before you begin this chapter (and subsequent chapters), make
sure that FrameMaker has been started at your workstation (if it
has been, the main FrameMaker window appears on the screen).
For more information, see Starting FrameMaker in Chapter 2.

Notes

In the remaining chapters of this manual, you’ll work with one
document, a project proposal, that is like many of the documents
you’ll be using FrameMaker to create. As you progress through
this manual, you’ll work with this document in much the same way
as you will with your own documents: you’ll edit it, format it, add
text and graphics to it, and change its page layout. You’ll begin
each chapter with a fresh version of the document, so feel free to
experiment as you go along.

23



Opening an existing document Chapter 3. Editing Text

Opening an existing document

To open the project proposal:
1. Click on OPEN in the main FrameMaker window.
The Open dialog box appears.

2. If there is a filename in the Open File Named edit box, delete
it.

3. In the Open File Named edit box, type the abbreviation for
your home directory (~) and click OK.

After a few moments, the contents of your home directory
appear in the scroll list.

4. In the scroll list, double-click on “fmtraining/.”

In a few moments, the contents of the fmtraining directory
appear.

5. In the scroll list, double-click on “Project3.doc.”

After a few moments, the first page of the project proposal
appears in a document window. If your screen is not large
enough to display an entire page, FrameMaker centers the
page in the document window.

Paging through a document

FrameMaker allows you to page through a document in several
ways.

Display the Page menu

1. Point in the word Page in the menu bar at the top of the
document window.

2. Press and hold down the right mouse button.

Previous !pp The Page menu appears. It contains several commands that
Next tpn allow you to page through a document: Previous, Next, First,
First tpf Last, Master, and Go To.

Last 'pl

Master !pm .

seen  1pe| GO to the next or previous page

g:dm' a : zg To go to the next page of a document:

Delete... !pd 1. Choose the Next command from the Page menu.

Page 2 of the project proposal appears.
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Paging through a document

To go to the previous page:
1. Choose the Previous command from the Page menu.

Page 1 appears.

Go to any page
To go to any page of a document:

1. Choose the Go To command from the Page menu.

The Go To dialog box appears.
ww
Orl ]
O Line: |:| First Page: 1
(O Master Page Last Page: 3
Current Line: none Current Page: 1

2. If the insertion point is not in the Page edit box, click the box.

3. Type the number 2 and click OK.
FrameMaker displays page 2 of the document.
Notes

In addition to the keyboard commands shown on the Page menu,
you can go to the previous page by pressing the F6 key, to the
next page by pressing the F7 key, and to any page by pressing
Ctrl-g (as long as the mouse pointer is inside the document
window).

Scroll between pages

Sometimes you need to check a paragraph that spans two pages.
For example, the paragraph at the bottom of page 1 of the project
proposal ends at the top of page 2.

To scroll between pages:

1. If you’re not already there, display page 2 of the project
proposal.

2. Choose the Scroll command from the Page menu.

The mouse pointer turns into the scroll cursor ( ™), shaped
like the outline of a hand.

3. Without pressing any of the mouse buttons, move the scroll
cursor to any spot near the top of page 2.
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4. Press and hold down the left mouse button.

5. Drag the scroll cursor down until the outline of the page moves
several inches down the screen.

6. Release the mouse button.

The window now shows the bottom of page 1 and the top of
page 2.

To stop scrolling and to display a full page again:

1. Click the middle mouse button anywhere in the document
window.

The mouse pointer turns back into an arrow.
2. Choose the Previous command from the Page menu.

The document window now displays page 1.

Moving text

Next, you’ll move a paragraph from the middle of page 1 to the
bottom of the page.

Set up guides

You’ll find it easier to edit text if you use some of the guides that
FrameMaker provides.

To turn on the borders and text symbols:
1. Choose the Borders command from the Guides menu.

A border appears around the text, defining the text column.
2. Choose the Text Symbols command from the Guides menu.

Paragraph symbols appear at the end of each paragraph.

Highlight the text to be moved
To highlight the text:

1. Under the heading Problem Statement, point on the beginning
of the second paragraph (the one that begins With a
sufficient). Be careful to point inside the column border.

2. Press and hold down the middle mouse button.
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The insertion point appears at the beginning of the paragraph.

;%irh a sufficient database provided by field examinaton, stress analy-:
s, and research, we could answer questions not only about the:
strength of each bridge, but also about the wisdom of using a particu-:
lar design under different circumstances. We could evaluate each:
bridge in the context of the total history of bridges in Maryland. {

If the insertion point didn’t appear, make sure the mouse
pointer is within the column border and try again. If the
insertion point appeared, but not at the very beginning of the
paragraph, move the mouse pointer and try again.

3. While holding down the mouse button, drag the pointer to the
end of the paragraph (to the right of the paragraph symbol) and
release the mouse button.

FV/1Th @ suticient darabase provided by Held examination, sress analy-j
sis, and research, we could snswer questions not only abour thej

strength of each bridge, but also about the wisdom of using a particu-j
ar design under different circumstances, We could evaluate eachf
ridge in the context of the total history of bridges in Maryland. § \

When you highlight the paragraph symbol, the entire line to the
right of the symbol is highlighted, telling you that you’ve
highlighted everything possible on the line.

If you highlighted the wrong text, repeat steps 1 through 3 above.

Cut the highlighted text

To move the text, you cut it from one location and then paste it to
another.

To cut the text:
1. Choose the Cut command from the Edit menu.

FrameMaker removes the paragraph from the page and puts it
on the Clipboard.

Notes

When you cut (or copy) something from a FrameMaker document,
it is placed on the FrameMaker Clipboard and in the X Window
text buffer. There is only one FrameMaker Clipboard, and it holds
only one thing at a time. For example, if you cut a word and then
cut another one later, the second word replaces the first word on
the Clipboard. The Clipboard can hold formatted text, graphics,
font settings, and paragraph formats.

The X Window system cut buffer holds characters only. You use it
to copy characters between FrameMaker and other X Window
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system applications. For more information, see the X Paste
command in Chapter 3 of the FrameMaker Reference Manual.

Paste the text
To paste the text at another location:

1. Point on the start of the paragraph just below the Potential
Benefits heading and click the middle mouse button.

Potential Benefits{ :

project of this type, using comnputer technology to both file and ana-:
I%e data on the bridge system, would set a new standard for state sur-:
;veys and would provide a basis for broader comparatve studiesg

The insertion point appears at the beginning of the paragraph.
2. Choose the Paste command from the Edit menu.
The paragraph reappears below the Potential Benefits heading.

Potential Benefitsq

‘With a sufficient database provided by field examination, stress analy-:
sis, and research, we could answer questions not only about the
strength of each bridge, but also about the wisdom of using a particu-:
lar design under different circumstances. We could evaluate each
bridge in the context of the total history of bridges in Maryland. § :

y-\ project of this type, using computer technology to both file and ana—é
lyze data on the bridge system, would set a new standard for state sur-:

g‘veys and would provide a basis for broader comparative studies na-:

Duplicating text

You duplicate text in much the same way as you move it. In this
case, you copy (rather than cut) the text from one location and
then paste it to another.

Duplicate text
To duplicate text:

1. Using the middle mouse button, highlight the first sentence of
the abstract, including the space after the sentence.

s of Marylend and prowvide a com-§
of these important struchures.

2. Choose the Copy command from the Edit menu.
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Duplicating text

3. Put the insertion point at the end of the same paragraph.

tion. A broader study will correlate bridge strength with age and struc-:
tural design to provide guidance in planning future design and construc-:
ton. s
Problem Statement

4. Choose Paste from the Edit menu.

A copy of the sentence appears at the end of the paragraph.

tion. A broader study will correlate bridge strength with age and struc-:
tural design to provide guidance in planning future design and construc-:
ton. This project will inventory the bridges of Maryland and provide a:
ccomputer database for detailed analysis of these important structures. i

Problem Statementf

Undo the duplication

If you change your mind after using a command, you can undo its
effect.

To undo your last action (pasting the text):
1. Choose Undo from the Edit menu.
The copied text disappears from the end of the paragraph.

tion. A broader study will correlate bridge strength with age and strue-:
tural design to provide guidance in planning future design and construc-:
don. ff :

Shortcuts

Because you use the Cut, Copy, Paste, and Undo commands
frequently, there are several shortcuts you can use for these
commands:

» Press and hold down the right mouse button (you don’t need to
move the mouse away from the highlighted text). The Maker
menu appears. The Cut, Copy, Paste, and Undo commands
appear on that menu, along with other frequently used
commands.

* Asa shortcut for the Cut command, press Delete or
Cul-w.

* As a shortcut for the Paste command, press Ctrl-y.

* As a shortcut for the Undo command, press Esc € u.
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Practice

You’ll probably cut, copy, and paste text often when you work on
your own documents. If you like, take a few moments to practice
on page 2 of the proposal (so that the rest of the instructions for
page 1 in this chapter will still work when you’re done).

Using the keyboard to edit text

You’ve learned to use the mouse and menu commands to move
the insertion point and to highlight and edit text. Since
FrameMaker also provides a complete set of keyboard commands,
you don’t have to move your hand back and forth between the
keyboard and the mouse.

Keyboard commands

Most keyboard commands involve pressing two or three keys,
either together or in succession. As a reminder:

When we say: We mean:

Press Esc f ¢ Press and release three keys in
succession: the Esc key, the
letter f, and the letter c.

Press Ctrl-e Press and hold down the Ctrl key
and then type the letter e.

Press Shift-Ctrl-e Press and hold down both the
Shift and Ctrl keys and then type
the letter e.

Move the insertion point

To move the insertion point using the keyboard:

1. Display page 2 of the project proposal.

2. Put the insertion point in the middle of the page.

3. Press each of the arrow keys (at the right side of your
keyboard).

The insertion point moves one character left or right, or one
line up or down, each time you press an arrow key.

4. Press Alt-f several times.
The insertion point moves forward one word at a time.
5. Press Alt-b several times.

The insertion point moves backward one word at a time.

30 FrameMaker User’s Manual



Chapter 3. Editing Text

FrameMaker User’s Manual

Using the keyboard to edit text

Press Alt-e several times.

The insertion point moves forward to the period at the end of
the sentence. (Alt-a moves it back to the end of the previous
sentence.)

Press Ctrl-e

The insertion point moves to the end of the line. (Ctrl-a moves
it to the beginning of the line.)

Delete text
To delete text using the keyboard:

1.

Put the insertion point in the middle of page 2 of the project
proposal.

Press Delete several times.

The characters to the left of the insertion point are deleted one
by one.

Press Ctrl-d several times.

The characters to the right of the insertion point are deleted
one by one.

Press Alt-Delete.

The characters back to the beginning of the current word are
deleted. (Alt-d deletes the characters forward to the end of the
current word.)

Press Ctrl-u.

Everything between the insertion point and the beginning of
the line is deleted.

Highlight text

To highlight a character at a time:

1.

Put the insertion point in the middle of page 2 of the project
proposal.

Press Esc h ¢. (The keystrokes are easy to remember, since
they stand for highlight character.)

The character to the right of the insertion point is highlighted.
Each time you press Esc h ¢, one more character is highlighted.

To highlight a word at a time:

L.

Put the insertion point in the middle of a word.
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2. Press Esc h w. (The keystrokes stand for highlight word.)

The current word is highlighted. Each time you press Esc h w,
one more word is highlighted.

You can also press Esc h s to highlight a sentence at a time,
Esc h1to highlight a line at a time, and Esc h p to highlight a
paragraph at a time. If text is already selected, Esc h s, Esch1,
and Esc h p extend the selection to the end of the current
sentence, line, or paragraph, respectively.

Highlight a large block of text

To highlight a large block of text:

1. Put the insertion point at the beginning of the block of text.
2. Move the mouse pointer to the end of the block of text.

3. Press and hold down Shift and then click the middle mouse
button.

All the text between the insertion point and the mouse pointer
is highlighted. This is a convenient way to highlight a large
block of text, particularly when the text spans pages.

Transpose characters

A common typing error involves accidentally typing a word with
two characters transposed (for example, Fraem instead of Frame).

To transpose two characters to correct this common mistake:
1. Put the insertion point between two characters in a word.
2. Press Ctrl-t.

The characters on either side of the insertion point are
transposed.

Use page 2 of the project proposal to experiment with these
commands until you’re comfortable with them. Other keyboard
commands for highlighting and editing text can be found in
Appendix A of the FrameMaker Reference Manual.

Searching for and replacing text

With FrameMaker, you can search for words or phrases (and
replace them, if you want). This feature is useful when you need to
make the same change repeatedly in a long document.
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Searching for and replacing text

Display the Search window

Before you search for text in your document, display the Search
window:

1. Choose the Search command from the Edit menu.

The Search window appears.

Search for:p|| J

Change to: | ]
(] whole Word [] consider case

Search Direction: @ Forward O Backwart

Change All Scope: @ All of Document (O current Selection

( search ] [ cnange ] [ change & SearchAgain | [ change All )

Unlike the dialog boxes you have seen so far, the Search
window can remain on the screen while you work in other
windows.

2. If the Search For edit box contains any text, click the box and
delete its contents. Do the same for the Change To edit box.

Move the Search window

The Search window may overlap the document window on your
screen. Since your workstation has a large screen, you’ll usually
move the Search window so that it doesn’t overlap your document.

For information on moving windows, see your window system
documentation.

Specify the search and replacement text
To specify the search and replacement text:
1. Point in the Search window.

2. If the insertion point isn’t in the Search For edit box, click the
box to put the insertion point there.

3. Type strength
The text appears in the Search For edit box.
4. Click the Change To edit box and type structure integrity

If you make a mistake while typing in an edit box, you can edit the
text in the same way that you edit text in a document window.

33



Searching for and replacing text Chapter 3. Editing Text

To edit the text in an edit box:

1. Point just to the right of the word structure in the Change To
edit box in the Search window.

2. Click the middle mouse button. (Actually, any mouse button
works here, but using the middle mouse button is consistent
with the way you would put the insertion point in a document
window.)

The edit box insertion point appears to the right of the word
structure.

Change to: §| structure|integrity ]

3. Press Delete to delete the e in structure.

Type the letters a and 1.

The word structure has been changed to structural.
Notes

To change more than one or two characters in an edit box, you can
highlight text in an edit box in the same way as in a document
window: Point at the beginning of the text you want to change,
press and hold down the middle mouse button, and drag the mouse
through the text. Any mouse button works here, but as before,
using the middle mouse button is consistent with the way you
would highlight text in a document window. If you like, take a few
moments to practice highlighting text in the Search window edit
boxes.

You can also use the keyboard commands that you learned earlier
in this chapter to move the insertion point, highlight, and delete
text in an edit box.

To search for text:

1. Click the check boxes and buttons in the Search window as
necessary until the window looks exactly as shown below.

Search for: [strength |

Change to: ) structural integrity] |

] whole word [] consider case
Search Direction: @ Forward O Backward
Change All Scope: @ All of Document (O Current Selection

[ search ] [ change ] [ Change & Search Again | [ change All ]
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Searching for and replacing text

2. Display page 1 of the project proposal and put the insertion
point at the beginning of the first paragraph.

3. Click the Search button.

FrameMaker starts searching the document at the insertion
point. In a moment it highlights the first occurrence of strength
on page 1 of the proposal.

Abstractﬂ :
‘This project will inventory the bridges of Maryland and provide a com—,
puter database for detailed analysis of these important structures. The:
‘computer-assisted analysis will provide criteria for evaluating the!
of the state’s bridges. A list of bridges with serious stmcturalg

Notes

Any time you want to search for text, follow the same basic steps:
+ Point on the Search window.
» Type the appropriate text in the Search For edit box.

» If you want to replace the text, type the replacement text in the
Change To edit box.

« Put the insertion point in your document.

* Click the appropriate button at the bottom of the Search
window.

Note that you must have the insertion point within a document for
FrameMaker to know which document to use.

Replace text
Now that FrameMaker has found the word, you can replace it.
To replace a word:
1. Click the Change button.
FrameMaker changes the text.

Abstract]

‘This project will mventory the bridges of Maryland and provide a com—
puter database for detailed analysis of these important swuctures. The:
‘computer-assisted analysis will provide criteria for evaluatng the!
structural integrity] of the state’s bridges. A list of bridges with serious:

2. To find the next occurrence, click Search again.

The next occurrence of strength is highlighted.
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Replace text and find the next occurrence
To replace the text and find the next occurrence with one action:
1. Click Change & Search Again.

FrameMaker changes the text and then searches until it finds
and highlights the next occurrence.

2. Click Change & Search Again once more.

Since strength does not appear anywhere else in the document,
FrameMaker displays an alert box telling you that it could not

find the text.
ok )
Not found.
3. Click OK.
The alert box disappears.

Search for a whole word

Normally, FrameMaker finds all occurrences of the Search For
text, whether the text is a word by itself or part of a larger word.
For example, suppose that we want to change the name Mary to
Judy.

1. Delete the contents of the Search For edit box and type Mary

2. Put the insertion point at the top of page 1 of the project
proposal.

3. Click the Search button.
FrameMaker highlights the name Mary.
4. Click the Search button again.

This time, FrameMaker highlights the first four letters of the
word Maryland.

If we had changed all occurrences of Mary to Judy, FrameMaker
would also have changed Maryland to Judyland.

To prevent this from happening:‘

1. In the Search window, click in the Whole Word check box to
turn on the Whole Word setting.

Now FrameMaker will find Mary but not the beginning of
Maryland.

36 FrameMaker User’s Manual



Chapter 3. Editing Text

FrameMaker User’s Manual

Searching for and replacing text

Consider case

Sometimes capitalization will be important when you search for
text. For example, suppose that you want to change we to you.
Normally, FrameMaker will disregard the capitalization in the
Search For text, replacing both we and We with you. To replace
text correctly, click the Consider Case setting in the Search
window and then use the Search command twice: Replace we with
you and then replace We with You.

Important

You can search forward or backward in a document. FrameMaker
always starts searching at the insertion point and searches the
entire document. If you are searching forward, FrameMaker
searches from the insertion point to the end of the document and
then from the beginning of the document to the insertion point.

You can search for characters that cannot be typed directly in the
Search For edit box (such as tab characters and paragraph
symbols). For more information, see the Search command in
Chapter 3 of the FrameMaker Reference Manual.

You can use UNIX regular expressions in the Search For edit box.
For more information, see the Search command in Chapter 3 of the
FrameMaker Reference Manual and your UNIX system
documentation.

If you want to search for and replace every occurrence of some
text, click the Change All button. Notice, however, that clicking
Change All may have unexpected results. For example, a period

(.) is a UNIX regular expression that represents any character.

Thus, if you search for a period and replace it with a comma,
FrameMaker will change every character in your document to a
comma! Before you click the Change All button, search for the text
several times to be sure that FrameMaker does what you expect.

Close the Search window
To close the Search window:

1. Point in the Search window.

2. Press Esc d q (for document quit).

The Search window disappears from the desktop.
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Quitting a document without saving changes
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Since you should save your documents frequently, you may want
to save your project proposal now. Because you’ll use a new
version of the project proposal for Chapter 4 of this manual,
however, you can quit the document you’re working on without
saving the changes you made.

To quit a document without saving changes:
1. Choose the Quit command from the Document menu.

FrameMaker displays a dialog box asking you if you want to
save your changes before quitting the document. In addition,
the small triangle pointing to the Yes button indicates the
active button in the dialog box.

Save changes before quitting?

)LYes ] [ No ] (Cancel]

2. Press Tab.

Notice that the No button is now the active button in the dialog
box (the triangle points to the No button). In general, press
Tab to move forward in a dialog box; press Shift-Tab to move
backward in a dialog box.

3. Press Enter. Pressing Enter has the same effect as clicking in
the active button (the button pointed to by a black triangle) in
the dialog box.

The changes you made to this document are not saved.

In this chapter you learned how to:

* Move from page to page within the document.
« Copy and move text.

» Edit text without using the mouse.

» Search for and replace text.

* Quit a document without saving changes.

FrameMaker User’s Manual



Chapter 3. Editing Text

What’s next

FrameMaker User’s Manual

What’s next

In Chapter 4, you’ll begin formatting your project proposal. You’ll
learn how to change fonts, paragraph spacing, alignment, and
margins. You’ll also learn how to control hyphenation in your
document. Finally, you’ll print your document.
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In this chapter you’ll learn how to format your project proposal. In
particular, you’ll learn how to:

[

Change fonts.

Change paragraph formats.
Change paragraph margins.
Control hyphenation.

Print your document.

Close your document into an icon.

Open your document
To open the project proposal:

1. Use the OPEN command in the main FrameMaker window to

open the document: ~/fmtraining/Project4.doc

If you’ve forgotten how to use the OPEN command, see
Opening an Existing Document in Chapter 3.

In this chapter, you’ll format your proposal so that it’s more
pleasant to look at and draws the reader’s attention to the
relevant information.

Change the font of existing text

Words spelled in all uppercase usually draw more atténtion to
themselves than the writer intended and are harder to read than
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words in mixed upper- and lowercase letters. If you need to type
words in all uppercase (for example, trademarks or product
names), you can make the words less obtrusive by putting them in
a smaller font.

To change the point size of text:

1.

Highlight the word MADCAP (about two-thirds of the way
down the page).

To highlight the word quickly, point on the word and double-
click the middle mouse button (quickly press and release the
mouse button twice in succession).

Choose the Fonts command from the Format menu.

The Fonts dialog box appears, showing you the font settings of
the highlighted text. For more information on each of the
settings, see the Fonts command in Chapter 3 of the
FrameMaker Reference Manual.

X Font Family: X styte: (ox )
[ Bow Cancel

- (Ccancer )
(] undertine [ Keep Settings
. [ strike Through

Size:
Apply to: Position: Point
@ current @ Normal

Ovag: [ | O superscript (X Spread Pts:

Oa O Subscript 5

In the Size area of the Fonts dialog box, click on the Point box.

The point size increases to “18.” Each time you click, the
point size increases; after “24,” it starts over again at “7.” If
you press and hold down the Shift key and then click on the
box, the point size decreases.

Change the point size to “12.”

5. Click OK.

The highlighted text is now 12 points.
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Changing fonts

Notes

If you highlight text that contains a mixture of font settings,
FrameMaker shows the settings for the first highlighted character.
For example, if you highlight displayed on a MADCAP terminal in
the project proposal and then choose the Fonts command from the
Format menu, you’ll see these settings in the Fonts dialog box.

[X] Font Family: X styie: ( ox }
»| Courier B
Tines ]| e
[ tatic
[ underiine [[] keep Settings
i [] strike Through
[ size:
Apply to: Position: Puoint
@ current @ Normal
O [ —]| |OQowmewt | gomurs
Qau O Subscript R ]

In the dialog box, FrameMaker displays the font characteristics of
the highlighted text. FrameMaker displays the Font Family check
box turned on because all the highlighted text is in the same font
family (Times). Notice, however, that FrameMaker displays the
Size check box turned off and that the Size value is “14.” The Size
check box is turned off because the highlighted characters are not
all the same size; the value is “14” because that is the size of the
first highlighted character.

If you change the Point setting to 12, the Size check box is
automatically turned on, indicating that FrameMaker will change
all highlighted text to 12 points, regardless of the current size.

Change the font while typing

You can change fonts as you type (rather than typing text in one
font and then changing the font later by highlighting the text).

To change the font as you type:
1. Put the insertion point at the end of paragraph containing Ed
Malick (under the Organization heading).

gKarl Wasco, Executive Assistant{
Ed Malicky
' ]

Insertion point
2. Type a comma and a space.

3. Choose the Fonts command from the Format menu.
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Undo

Cut

Copy

Copy Font

Copy Pgf Format
Paste

Fonts...
Catalog. ..
Paragraphs. ..

leu

lex
lec
lef
leg
lep
Iff
Ifc
Ifp
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In the Style area, click the Italic check box and click OK.
Type Manager

The word appears in italics as you type.

Copy fonts

You can copy the font settings from one block of text to another.

To copy the font settings:

1.

Highlight a few characters in the word Manager that you just
typed in italics.

Ed Malick, 3(ggcery

Press and hold down the right mouse button; you don’t need to
move the mouse away from the highlighted text.

The Maker menu appears.

Choose the Copy Font command from the Maker menu.

The font settings of the highlighted text have been copied to
the Clipboard.

Highlight Jane Parmenter’s title, Vice-president.

tane Pamenve, Y

Choose the Paste command from the Edit or Maker menu.

The highlighted text now appears in italics (FrameMaker
copied the font settings from the Clipboard to the highlighted
text).

Jane Parmenter,

The font settings remain on the Clipboard so that you can
paste them again.

Highlight Kevin Susco’s title (Stress Analyst) and choose the
Paste command again.

Use keyboard commands to change fonts

You can bypass the fonts dialog box entirely by using keyboard
commands.

To change fonts with a keyboard command:

1.

Highlight Karl Wasco’s title (Executive Assistant).

Karl Wasco, BEEaui S ey
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Changing paragraph formats

2. Press the F3 key.
The highlighted text appears in italics.

3. Highlight Engineering Staff in the last line of the Organization
section of the proposal and press the F3 key again.

Notes

The keyboard commands that change font styles are shown below.
For a complete list of keyboard commands that change fonts, see
Appendix A of the FrameMaker Reference Manual.

To change to: Press:

Regular text The F1 key
Bold The F2 key
Italic The F3 key
Underline The F4 key
Overstrike The F5 key

We recommend that you show text in bold or italic for emphasis
rather than underlining the text and that you avoid using more than
one font style for the same text. For example, change text to bold
or italic but not to bold and italic.

Changing paragraph formats

FrameMaker User’s Manual

In FrameMaker the term paragraph format refers to many
settings: default font, line and paragraph spacing, alignment,
indents, tab settings, hyphenation, and more. In this section you’ll
change some of the paragraph settings; you’ll explore more of
these settings in Chapters 4 through 6.

As you change paragraph formats, you’ll see how easy it is to
change the format associated with a particular paragraph tag and
to apply those changes to all paragraphs with that tag.

Change paragraph spacing

Headings should stand apart from their surrounding text. The
headings in our proposal, however, have the same spacing as the
other paragraphs around them.

To change the paragraph spacing:
1. Put the insertion point in the Organization heading.

2. Choose the Paragraphs command from the Format or Maker
menu.
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The Paragraphs dialog box appears.

Leftindent: M 0.00] | Line Spacing: | 2pt
First Line: spacepetore: [opt | (el )
s st

Language
Tag: BlockLines: [ 1 ] [ uSengish |
[ keep with Next Paragraph
@ Left O Right [ start at Top of TextRect

O centered () Justified [[] Hyphenate - Tolerance: E
L

Apply ta: Font:

X current [Gourier — %3] [X] Bold

Ores M| CJrsc [55] e
COan Symbal [J undertine

[ catalog Garamond _[3| [] Strike Through

If you are using the International version of FrameMaker, the
Language setting in the dialog box will be UKEnglish.

3. Delete the contents of the Space Before edit box.

Type 14 (You don’t have to type pt; FrameMaker assumes
that you mean 14 points.)

. Press Tab to move to the Space After edit box.

The contents of the Space After edit box are highlighted.

. Type8

The number 8 appears in the edit box, replacing the previous
contents.

Click OK.

The heading paragraph now has more space separating it from
adjacent paragraphs.

Civil Engineering Department(|

EOrganizatinnﬂ
§The Civil Engineering Department consists ofi{
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Changing paragraph formats

Notes

The Line Spacing setting is the amount of space in points (one
point is approximately 1/72") after each line in the paragraph. This
space is sometimes referred to as leading (thymes with heading).
The Space Before and Space After settings determine the amount
of extra space above and below the paragraph.

If you control the spacing between paragraphs by specifying the
Space Before and Space After settings appropriately, rather than
by pressing the Return key several times, it will be much easier to
reformat your documents later.

Apply format changes to similar paragraphs

You can copy the paragraph format settings from one paragraph to
another in much the same way as you earlier copied font settings
from one block of text to another. In this case, you would use the
Copy Pgf Format command on the Maker menu (Pgf stands for
Paragraph). Such an approach isn’t practical, however, when you
need to change the format of many paragraphs. FrameMaker
provides a faster and more powerful way to change the format of
similar paragraphs, allowing you to apply changes to all
paragraphs having the same tag.

To display the Paragraphs dialog box for the heading paragraph:

1. Make sure that the insertion point is in the heading you
reformatted.

2. Choose the Paragraphs command from the Format or Maker
menu.

The Paragraphs dialog box appears. Notice that the
paragraph’s tag (“heading ”’) appears in the Tag edit box, in
the upper-left portion of the dialog box.

Left Indent:
First Line:
Right Indent:

Tag:  [heading <——]—— The tag of the paragraph

containing the insertion point

The tag “heading” also appears in the bottom border of the
document window.
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3. Now look at the Apply To area, in the lower-left corner of the
dialog box.

Apply to:
Current
[] Tag: Iheading

[Jan

[] catalog

If you were to click OK now, only the current paragraph (the one
containing the insertion point) would be affected by any format
changes. However, we want to apply the changes in spacing to
every “heading” paragraph.

To change the spacing of all “heading” paragraphs:

1. In the Apply To area of the Paragraphs dialog box, click the
Tag check box.

Apply to:

< current

Tag:»| heading ]

[Jan

[] catalog

When you click the Tag check box, you are specifying that the
format should be applied to every paragraph whose tag is
“heading.”

2. Inthe Apply To area of the Paragraphs dialog box, click the
Catalog check box.

Apply to:
Current
Tay: lheading

[Jan
»[<] Catalog

When you click the Catalog check box, you are specifying that
the format for this paragraph is to be stored in the paragraph
Catalog under the tag “heading” (the current paragraph’s

tag).
3. Click OK.

A confirmation dialog box appears, asking if it’s “OK to
overwrite existing catalog entry?”

4. Click OK.
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Changing paragraph formats

Notice that three things happen. First, every paragraph in this
document with the tag “heading” is reformatted. Second, since
the document no longer fits on one page, FrameMaker adds a
second page. Finally, the new “heading” paragraph format is
saved in the Catalog, overwriting the format that we had
already saved there. As a result, all new “heading”

paragraphs will be formatted as you just specified.

Change paragraph alignment

The text in the main paragraphs of the proposal is justified (both
the left and right edges of the text line up). To justify a line of text,
FrameMaker changes the spacing between words. Text is
generally easier to read, however, if the spacing between words is
consistent. To make the proposal easier to read, you will change
the text to be left-aligned.

To change paragraph alignment:

1.

Put the insertion point in the paragraph below the Abstract
heading.

Choose the Paragraphs command from the Format or Maker
menu.

The Paragraphs dialog box appears.
In the dialog box, click the button next to Left.

@ Left (O Right
(O centered () Justified

When you turn on the Left setting, indicating that the
paragraph is to be left-aligned, the Justified setting is turned
off.

In the Apply To area, click the Tag check box.

This format will be applied to every “body” paragraph.
In the Apply To area, click the Catalog check box.
Apply to:

Current

Tag: lhody ]
Clan

»[<] Catalog

This paragraph format will be stored in the paragraph Catalog
under the tag “body” (the current paragraph’s tag).
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6. Click OK.
7. When the confirmation dialog box appears, click OK again.

All “body” paragraphs in the proposal are now left-aligned. In
addition, because you applied this change to the Catalog, new
“body” paragraphs will also be left-aligned.

Creating indented paragraphs

50

To be most readable, the width of a line of text should be between
40 and 60 characters. To shorten the lines in the proposal, you’ll
indent the left sides of the paragraphs.

To create an indented paragraph:

1. Make sure that the insertion point is in the paragraph below
the Abstract heading.

2. Look at the ruler at the top of the document window.

Three symbols mark the beginning and end of lines in the
paragraph.

Edit Format TextRects Guides Page

First-line indent symbol
Left indent symbol
Right indent symbol

The right indent symbol determines where lines end. The first-
line indent symbol controls where the first line of the paragraph
begins. The left indent symbol controls where the other lines in
the paragraph begin.

3. Point in the first-line indent symbol (make sure that the tip of
the mouse pointer overlaps the indent symbol).

4. Press and hold down the left mouse button.

5. Drag the first-line indent symbol 1/2" to the right (to the 2"
position on the ruler) and then release the mouse button.

Edit
1|

TextRects Guides

3

Format Page

L e B

The first line of the paragraph is indented.

Abstracty

[This project will inventory the bridges of Maryland and provide
a computer database for detailed analysis of these important struc-
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6. In the same way, drag the left indent symbol to the 2" position
on the ruler.

Edit Fonmat TextRects Guides
i)

1!'*4'!‘!“.1!'

Page

All other lines in the paragraph are indented.

Abstract{]

[This project will inventory the bridges of Maryland and provide
a computer database for detailed analysis of these important

Since the margin settings are part of a paragraph’s format, you can
now apply these changes to other “body” paragraphs as you did
before.

To reformat the other “body” paragraphs (and change the
Catalog):

1. Choose the Paragraphs command from the Format or Maker
menu.

2. Inthe Apply To area of the Paragraphs dialog box, click both
the Tag and Catalog check boxes.

3. Click OK.
4. When the confirmation dialog box appears, click OK again.

All “body” paragraphs in the proposal are indented. In
addition, because you applied this change to the Catalog, new
“body” paragraphs will be indented.

Hyphenating text

Notice that FrameMaker hyphenates words automatically in the
proposal. You can turn automatic hyphenation on and off at the
paragraph level or in the entire document. You can also prevent
hyphenation in specific words or allow hyphenation at a specific
place in a word.

Turn off automatic hyphenation in a paragraph
To turn off automatic hyphenation in a paragraph:

1. Make sure that the insertion point is in the paragraph under
the Abstract heading.

2. Choose the Paragraphs command from the Format or Maker
menu.
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The Paragraphs dialog box appears. Notice that the
Hyphenate - Tolerance setting is turned on.

[[] keep with Next Paragraph
[[] start at Top of TextRect
Hyphenate - Tolerance: |4 |

[[] Auto Number - Format: I |

3. Click the Hyphenate - Tolerance check box.
The automatic hyphenation setting is now turned off.

4. Inthe Apply To area, click both the Tag and Catalog check
boxes.

5. Click OK.
6. When the confirmation dialog box appears, click OK again.

FrameMaker removes all hyphenation in the current paragraph
as well as in all “body” paragraphs.

To undo this last action:
1. Choose the Undo command from the Edit or Maker menu.
Notes

In the Paragraphs dialog box, the edit box to the right of
Hyphenate - Tolerance usually contains the number 4. This
number controls how many consecutive lines in a paragraph may
be hyphenated. For example, a setting of / means that no two
consecutive lines may be hyphenated, 2 means that two
consecutive lines (but not three) may be hyphenated, and so on.

Occasionally you may want to turn automatic hyphenation on or off
for several paragraphs or for an entire document without changing
other paragraph format settings. For information on how to do this,
see the Auto Hyphenation command in Chapter 3 of the
FrameMaker Reference Manual.

If you’re using the International version of FrameMaker, you
change the hyphenation rules for each paragraph in your document
by changing the paragraph’s Language setting. For example, if
your document is primarily in English, but you have a short
passage in German, change the Language setting in the

Paragraphs dialog box for the German paragraphs to German.
FrameMaker will then apply German hyphenation rules to those
paragraphs.
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Suppress hyphenation

FrameMaker may hyphenate a word that you don’t want
hyphenated. For example, suppose that you don’t want
FrameMaker to hyphenate the computer name MADCAP in the
paragraph above the Problem Statement heading.

To suppress hyphenation:
1. Put the insertion point anywhere in the word MADCAP.

2. Press and hold down the Ctrl key and then type a
hyphen (-).
The entire word moves to the beginning of the next line, and

the hyphen disappears. A suppress hyphenation symbol
appears on the screen but will not print.

You may want to prevent a line break between two words. To
prevent a line break between words, insert a nonbreaking space
between the words instead of a regular space. To type a
nonbreaking space, press and hold down Alt and then type a
space.

Allow hyphenation at a specific place in a word

FrameMaker is conservative in its hyphenation; it may not
hyphenate a word where you want it to. For example, near the
bottom of the first paragraph under the Abstract heading, you
might want to hyphenate the word study to even out the ragged
right edge of the paragraph.

To insert a discretionary hyphen:

1. Put the insertion point between the u and d of study.

in planning corrective action and reconstructon. A broader
study will correlate bridge structural integrity with age and struc-
tural design to provide guidance in planning future design and
construction,

2. Press and hold down Alt and then type a hyphen (-).
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FrameMaker hyphenates the word study, and a discretionary
hyphenation symbol appears on the screen but will not print.

in planning corrective action and reconstructon. A broader stif
Py will correlate bridge structural integrity with age and structur-
al design to provide guidance in planning future design and con-

structon. Discretionary hyphenation symbol

Delete hyphenation symbols

If you change your mind about suppressing hyphenation or
inserting a discretionary hyphen, you can delete the corresponding
hyphenation symbol just as you delete any other character. Since
these symbols have zero width, however, they are more difficult to
highlight than regular text. We suggest that you follow the steps
below when you want to delete a hyphenation symbol.

To delete a suppress hyphenation or discretionary hyphen symbol:
1. Put the insertion point at the beginning of the word MADCAP.
2. Press the right-arrow key.

The insertion point moves one character to the right.

3. Press the right-arrow key until the insertion point appears not
to have moved.

This means that you have just moved the insertion point to the
right of the suppress hyphenation symbol.

4. Press Delete.

The suppress hyphenation symbol disappears, and
FrameMaker again hyphenates the word automatically.

Notes

You can also use the Search command to search for hyphenation
symbols. For more information, see the Search command in
Chapter 3 of the FrameMaker Reference Manual.

Printing a document
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Now that you have formatted the document, you may want to print
it.

To print a document:

1. Choose the Print command from the Document menu.
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The Print dialog box appears.
Print Page Range: g
Print Odd-numbered Pages
@A [X] Print Even-numbered Pages
O current X Collate

@] SMPﬂae»E:I [X) Print Last Page First
End Page: [[] Print Low Resolution Images
Pgo [1 | L e

P e )

Printer File: | ~/Project4.ps ]

2. Click OK.

The mouse pointer turns into an hourglass for a moment while
FrameMaker starts the printing process. When the hourglass
turns back into a pointer, you can continue working with the
document.

Closing and quitting a document

If you want to put the proposal aside but have it readily available
on your desktop, you can close the document window into an icon.
For information on closing a window into an icon, see your window
system documentation.

When you close a window into an icon, the document is still in the
workstation’s memory, allowing FrameMaker to redisplay the
document window quickly. In contrast, the Quit command removes
the document from memory, making that memory available for
other documents. When you are through working on a document
for a while, you should save it and quit the document, rather than
close it.

To quit a document window:
1. Choose the Quit command from the Document menu.

FrameMaker asks you if you want to save changes before
quitting.

2. If you want to save the document, click Yes. Otherwise, click
No. Since you’ll begin with a fresh proposal in Chapter 5, you
don’t need to save the changes.
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In this chapter you learned how to:

Change fonts.

Change paragraph formats.
Change paragraph margins.
Control hyphenation.

Print your document.

Close your document into an icon.

In Chapter 5, you’ll learn how to create, move, and delete tab
stops. You’ll use tabs to create paragraphs with a hanging indent
and to create simple tables.
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In this chapter you’ll learn how to:

» Create, move, and delete tab stops.

¢ Create a paragraph with a hanging indent.
* Create a simple table using tabs.

» Change the width of a table column.

Open your document
Before you begin:
1. Open the document: ~/fmtraining/Project5.doc

If you’ve forgotten how to use the OPEN command, see
Opening an Existing Document in Chapter 3.

2. Display page 2 of the proposal.
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Creating a hanging indent

From time to time, you may want to create a paragraph with a
hanging indent, such as the following example.

Note: Eventually we will add smaller bridges to our database, thus great-
ly expanding the amount of information and making possible a more
thorough analysis of general bridge conditions.

You might use a similar format for tables or glossary entries.

Set indents

To create a hanging indent, you first set the paragraph indents
appropriately.

To set the paragraph indents:

1. Put the insertion point at the beginning of the last full
paragraph on page 2 of the proposal (the paragraph begins
with Eventually we will add).

2. Type Note:

The paragraph now has the correct text but the wrong
indentation.

Note:Eventually we will add smaller bridges to our database, thus greatly
expanding the amount of information and making possible a more thorough
analysis of general bridge conditions. This information is especially impor-
tant, since 50% of Maryland’s bridges span waterways less then fifteen
feet wide. Analysis of this expanded database will provide the Department
of Public Works with a detailed analysis of every bridge in the state, for
the first ime §

3. In the ruler at the top of the document window, move the left
indent symbol to the 2-1/2" position. (If you’ve forgotten how,
see Creating indented paragraphs in Chapter 4.)

Every line in the paragraph, except for the first line, now
begins 2-1/2" in from the edge of the page.

Note:Eventually we will add smaller bridges to our database, thus greatly
expanding the amount of information and mjking possible a more
thorough analysis of general bridge conditions. This information is
espedially irnportant, since 50% of Maryland’s bridges span water-
ways less than fifteen feet wide. Analysis of this expanded data-
base will provide the Department of Public Works with a detailed
analysis of every bridge in the state, for the first time.{
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Create tab stops

If you add spaces to try to line up the word Eventually with the
text below it, you may come close, but the word will still be a little
too far to the left or right. Instead, you need to create a tab stop at
the appropriate place and then use a tab character to align the
word Eventually with the lines below it.

To create a tab stop:

1.

Choose the Tabs command from the Format menu.
The Tabs dialog box appears.

Alignment
@ left ¢
QO Center +
ORight #+
O pecimal +

In the Alignment area, click the Left button if it isn’t already
turned on.

FrameMaker will create a left-aligned tab stop.

In the Leader area, click None if it isn’t already highlighted
FrameMaker won’t add leader dots.

Click OK.

A left-aligned tab stop symbol (4 ) appears at the 2-1/2"
position on the ruler (at the same place as the left indent
symbol). FrameMaker actually put the tab stop 1" in from the
left column border. You can then drag the tab stop to any
position on the ruler, as you do the indent symbols.

Align text with a tab stop
To align the text with the tab stop you created:

1.
2.

If you typed any spaces in the text, delete them.

Make sure that the insertion point is right after the colon (:)
that follows Note.

Press Tab.
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FrameMaker inserts a tab character, and the text now aligns.

Note:} Eventually we will add smaller bridges to our database, thus great-
y expanding the amount of information and making possible a more
thorough analysis of genersl bridge conditions. This information is
espedially important, since 0% of Maryland’s bridges span water-
ways less than fifteen feet wide. Analysis of this expanded data-
base will provide the Department of Public Works with a detailed
analysis of every bridge in the state, for the first ime.{[

Create a new paragraph format

Notice that the tag of the paragraph you just changed is “body.” If
you later make a global formatting change to all “body”
paragraphs, this paragraph will be reformatted to look like the
other “body” paragraphs, even though you probably want to keep
the format as you just specified. To avoid inadvertent changes to
this new format, it’s a good idea to change its tag. The Catalog
doesn’t, however, contain an appropriate tag for this paragraph.

To create a new tag for the paragraph and place the tag in the
Catalog:

1. Choose the Paragraphs command from the Format or Maker
menu.

The Tag edit box in the upper-left portion of the Paragraphs
dialog box (not in the Apply To area at the bottom of the dialog
box) contains the current tag of the paragraph (“body”).

Left indent: »[1.007] |
First Line:
Right Indent:
Tag:  |body ! Tag of the current paragraph

2. Replace the contents of the Tag edit box shown above with the
new tag for the paragraph (“note”).

This indicates that the tag of the current paragraph is to be
changed.

3. Inthe Apply To area at the bottom of the Paragraphs dialog
box, click only the Catalog check box. If you click the Tag check
box, you would apply the format changes to every “body”
paragraph.
This indicates that the tag (“note”) and its associated format
are to be saved in the Catalog.
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4. Click OK.

Notice that the paragraph tag (in the bottom border of the
document window) changes to “note.” If you display the
Catalog (using the Catalog command), you will find the tag
“note” added to the list of tags.

You have specified a new format for a paragraph with a hanging
indent, assigned the paragraph a tag (“note”), and stored the tag
and its associated format in the paragraph Catalog. If you later
need another paragraph to have the same format as the “note,”
you don’t need to use the Paragraphs command to change
paragraph format settings again. You only need to specify the new
tag (“note”) for the paragraph (using the Catalog command). The
paragraph will then be formatted using the settings that you
already specified.

Creating a simple table

FrameMaker User’s Manual

Next you’ll add this simple table to your project proposal:

Contacts Telephone Mail Stop
Edward Malick 555-6473, x432 E10-8
David Murray 555-2313 Ki1-A
Kevin Susco 555-8475, x421 B-3

Before you begin, find the place in the proposal where you will
insert the table:

1. Display page 1 of the proposal.

2. Put the insertion point at the end of the Primary Contacts
heading.

3. Press Enter.
Now you have an empty paragraph for the table heading.

Set up the paragraph format
for the table heading

First, set up the paragraph format for the table heading:

1. Move the first-line indent and left indent symbols to the 2"
position on the ruler.

Document Edit Format TextRects Guides

Page

2
I BPUE . o S R BN

2. Choose the Paragraphs command from the Format or Maker
menu.
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3. When the Paragraphs dialog box appears, change the Space
Before setting to 0.

Change the Space After setting to 0.

In the Font area, turn off the Bold setting.

Also, in the Font area, turn on the Underline setting.
Click OK.

NS e

Create tab stops for the table heading
Next, create the first tab stop for the table heading:
1. Choose the Tabs command from the Format menu.

2. When the Tabs dialog box appears, change the settings to
match the ones shown below (centered tab with no leader
dots).

Alighment
QOleft 2+
@ Center +

O Right  #
O Decimal +

3. Click OK.

A centered tab stop symbol (4) appears at the 2-1/2" position
on the ruler.

To move the tab stop to the correct location:
1. Point in the tab stop symbol under the ruler.
2. Press and hold down the left mouse button.

3. Drag the tab stop symbol to the right to the 4" position on the
ruler.

4. Release the left mouse button.
The tab stop symbol is now at the 4" position on the ruler.
To add another tab stop:

1. Point just under the 5-1/2" position on the ruler and click the
left mouse button.

A tab stop symbol appears at the 5-1/2" position on the ruler.

Fornmat TextRects Guides Page

1. .5, 1., |6 Center tab stop
+ +<——— symbol
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Notes

When you click the left mouse button at the position on the ruler
where you want the tab stop to appear, FrameMaker will add a
tab stop of the same type as the last one you created. You’ll find
this faster than using the Tabs command every time you want to
add a tab stop.

Type the table heading
Now type the heading for the table:
1. Type Contacts and press Tab.

The text appears underlined and the insertion point advances
to the first tab stop.

2. Type Telephone and press Tab again.

The text is automatically centered on the first tab stop and the
insertion point advances to the second tab stop.

3. Type Mail Stop and press Enter.
The column headings for the table should look like this:

Primary Contacts]
Contacts}) Telephone) Mail Stopf]
I
Notes

We experimented with the tab settings for the table you're
creating and decided on the settings specified in this manual.
When you create your own tables, you may want to type a few
lines of the table and then set the tab stops appropriately.

Set up the paragraph format for the table body
To set up the paragraph format for the table body:

1. Choose the Paragraphs command from the Format or Maker
menu.

2. Inthe Font area of the Paragraphs dialog box, turn off the
Underline setting.

3. Click OK.
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Create tab stops for the table body

The body of the table contains information that we want to left-
align with a tab stop, but the tab stops are centered. You need to
delete the existing tab stops and then create new left-aligned tab
Stops.

To delete the existing tab stops:
1. Point in one of the tab stop symbols on the ruler.
2. Press and hold down the left mouse button.

3. Drag the tab stop symbol downward into the document
window.

4. Release the left mouse button.

The tab stop symbol disappears.
5. Repeat steps 1 through 4 to delete the other tab stop symbol.
To create new tab stops:

1. Use the Tabs command from the Format menu to create a left-
aligned tab with no leader.

2. Move the new tab stop symbol to the 3-1/2" position on the
ruler.

3. Point just under the 5-1/4" position on the ruler and click the
left mouse button.

A left-aligned tab stop symbol appears at the 5-1/4" position
on the ruler.

Type the table body
To type the body of the table:

1. Type only the first line of the table body shown below,
beginning with the name Edward. Wherever you see a tab
symbol ( 3), press Tab. Don’t press Enter at the end of the

line.

Primary Contacts
Contacts) Telephone} Mail Stopy[
Edward Malick} 555-6473, x432y  E10-5¢
David Murray) 555-2313) K1-A{
Kevin Susco) 555-8475, x421y  B-3

Abstract{]

2. To begin a new line, press Alt-Enter (that is, press and hold
down the Alt key and then press Enter).
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Alt-Enter forces a new line to begin without starting a new
paragraph (a hard return). Using Alt-Enter, you’ll create the
entire body of the table as a single paragraph. Then it will be
easy to change column spacing within the table in one step.

3. Type the second line of the table, beginning with the name
David, then press Alt-Enter.

4. Type the last line of the table, but do not press Alt-Enter or
Enter at the end of the line.

Change the column width in the table
To change the width of a column in the table:

1. Drag the tab stop at the 5-1/4" position on the ruler to the 6"
position.

Since the body of the table is a single paragraph, the entire
column is realigned.

2. Put the insertion point in the table heading paragraph.

3. Drag the tab stop at the 5-1/2" position on the ruler to the
6-1/4" position.

The table heading is realigned over the new column position.

Create new formats for the table

Once you’re satisfied with the format of the table and its heading
paragraph, you would probably change the tags of the two
paragraphs and store the new formats and their tags in the
Catalog.

To create new formats for the paragraph and place them in the
Catalog:

1. Experiment with the format of the table and its heading if you
like.

2. Change the tag of the table heading paragraph to “tablehead”
and save the new format in the Catalog. If you’ve forgotten
how, see Create a new paragraph format, earlier in this chapter.

3. Change the tag of the table itself to “table” and save the new
format in the Catalog.
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Finishing up

Review

What’s next
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You’ll start the next chapter with a fresh copy of the proposal, so
you won’t need to save the changes you made in this chapter.

Before continuing:

1. Save the document if you like; then quit the document.

In this chapter you learned how to:

[ ]

Create, move, and delete tab stops.
Create a paragraph with a hanging indent.
Create a simple table using tabs.

Change the width of a table column.

In Chapter 6, you’ll learn how to use other paragraph format
settings to control paragraph placement and to create numbered
and bulleted lists.
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In this chapter you’ll learn how to use paragraph format settings
to control paragraph placement and to prefix paragraphs with
numbers or text automatically. In particular, you’ll learn how to:

* Prevent widow lines in a paragraph.

» Prevent a page break between a heading and the text that
follows it.

+ Create automatically numbered paragraphs.
* Create bulleted lists.

Open your document
Before you begin:

1. Open the document: ~/fmtraining/Project6.doc
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Preventing widow lines

Notice that the bottom of the first page of the proposal contains
the first line of a paragraph (the rest of the paragraph appears at
the top of page 2). This line is called a widow line.

To prevent widow lines:

1.
2.

3.

Put the insertion point in the last line on the page.

Choose the Paragraphs command from the Format or Maker
menu.

The Paragraphs dialog box appears, with a Block Lines setting
of 1.

Line Spacing:
Space Before:

Space After:

il

Block Lines:

The Block Lines setting specifies the minimum number of
paragraph lines that must be kept in a column of text, both at
the beginning and end of the paragraph. The current setting
allows the first and last line of the paragraph to appear alone
on a page of the proposal.

Change the Block Lines setting to 2.

To apply this change to all “body” paragraphs and to the Catalog:

L.

In the Apply To area of the Paragraphs dialog box, turn on both
the Tag and Catalog settings.

Click OK.

3. When a confirmation dialog box appears, click OK again.

Because page 1 of the proposal doesn’t have enough space to
contain two lines of the paragraph, the entire paragraph
appears on page 2.

Before continuing:

1.

68

Display the first page of the project proposal again.
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Preventing a page break between paragraphs

Now that you have changed the format of “body” paragraphs,
notice that the heading Potential Benefits appears at the bottom

of the first page of your proposal, but that the following paragraph
begins at the top of page 2.

To prevent a page break between a heading and the beginning of
the paragraph that follows it (throughout the document):

1. Put the insertion point in the heading Potential Benefits.

2. Choose the Paragraphs command from the Format or Maker
menu.

3. In the Paragraphs dialog box, turn on the Keep with Next
Paragraph setting.

»[X] Keep with Next Paragraph
[[] start at Top of TextRect

4. Inthe Apply To area of the Paragraphs dialog box, turn on both
the Tag and Catalog settings.

5. Click OK.
6. When the confirmation dialog box appears, click OK again.

FrameMaker now requires each “heading” paragraph to be on
the same page as the beginning of the paragraph that follows it.

Because page 1 of the proposal doesn’t have enough space to
contain the heading and two lines of the paragraph,
FrameMaker moves the heading to page 2.

Before continuing:

1. Display the first page of the project proposal again.

Creating numbered paragraphs

FrameMaker User’s Manual

Depending on the kinds of documents you create, you may often
need to create numbered paragraphs (for example, section
headings, figure titles, and lists). You can easily set up a
paragraph format that tells FrameMaker to number these
paragraphs for you automatically.

Create numbered section headings
To turn on automatic numbering:

1. Put the insertion point in the Organization heading.

Preventing a page break between paragraphs
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2. Choose the Paragraphs command from the Format or Maker
menu.

3. In the Paragraphs dialog box, turn on the Auto Number -
Format setting.

[] Hyphenate - Tolerance: I 4 I

Auto Number - Format: b| | |

FrameMaker will automatically precede the paragraph with the
text that you specify in the Auto Number - Format edit box.

To specify the text used to number the paragraph:
1. Inthe Auto Number - Format edit box, type +.\t

The plus sign (+) tells FrameMaker to insert a number. The
first numbered paragraph will begin with a 1, the second with a
2, and so on.

The period (.) tells FrameMaker to insert a period after the
number.

Finally, the backslash (\) followed by the letter ¢ tells
FrameMaker to insert a tab character. If the paragraph has a
tab stop at an appropriate position on the ruler, the text in the
numbered paragraphs will align.

2. Inthe Apply To area of the Paragraphs dialog box, turn on both
the Tag and Catalog settings.

3. Click OK.
4. When the confirmation dialog box appears, click OK again.

FrameMaker automatically numbers each “heading”-
paragraph.

1. Name of Department ar Organization{]

© Civil Engineering Department{]

iz.prgsﬁdzaﬁmﬂ[

The Civil Engineering D epartment consists of

Create the tab stop

Since there is no tab stop set for the “heading” paragraph, the
text for each numbered paragraph appears right next to the number.

To create a tab stop:

1. Put a left-aligned tab stop at the 2" position on the ruler.
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If you’ve forgotten how, see Creating a hanging indent in
Chapter 5.

One “heading” paragraph is now formatted correctly.
1. Name of Department ar Organizationy]
:  Civil Engineering Department]]
2) Orgajizationy
: The Civil Engineering Department consists of{]
To apply this format to the other “heading” paragraphs:

1. Choose the Paragraphs command from the Format or Maker
menu.

2. Inthe Apply To area of the Paragraphs dialog box, turn on the
Tag and Catalog settings.

3. Click OK.
4. When the confirmation dialog box appears, click OK again.

FrameMaker adds the tab stop to all other “heading”
paragraphs in the proposal and to the “heading” tag in the
paragraph Catalog.

Notes

Creating numbered paragraphs

FrameMaker’s automatic paragraph numbering feature can handle
all of your paragraph and list numbering needs.

Example 1:

If you want automatic section and subsection numbering, specify
the following automatic numbering formats:

1.0 Chapter Title Auto Number - Format

1.1  Section Title

Chapter headings: +.08
12  Section Title ) .
1.21 Subsecton Title <—\ Section headings: #4\
1.22 Subsection Tide Subsection headings: #.#.+\t

1.3  Section Title
2.0 Chapter Title

Chapter, section, and subsection paragraphs each have a different
tag and format. In the chapter headings above, the plus sign (+)
causes a counter to start at 1 and add 1 with each occurrence; the
period (.) and O appear after the automatically generated number.
As a result, the first chapter heading is numbered /.0, the second
is numbered 2.0, and so forth.

In the section headings, the pound sign (#) causes FrameMaker
to use the value of the corresponding counter in the previous
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chapter heading; the period (.) appears after the number, followed
by another counter value (+). As a result, the first section heading
is numbered 1.1, the second is numbered /.2, and so on.
Subsection headings are created in a similar way.

Example 2:

If you want to number the items in a list (like the numbered steps
in this manual), specify the following automatic numbering formats:

1. Firstitem in the list
2 Other item (_\ Auto Number - Format
3. Otheritem First item in list: 1M
4. Other item . Lo
o ) Other items in list: +\t
1. Firstitem in new list
2. Otheritem
3. Otheritem

The first item in the list has a different tag and automatic
numbering format than the subsequent items in the list. The first
item in the list will always be numbered /; successive items in the
list will be numbered sequentially. Using the two automatic
numbering formats you can have several numbered lists in a
document, one after another; each new list will begin with the
number /.

Example 3:

If your list appears within other automatic numbering sequences,
you want the sequences not to interfere with each other. To
accomplish this, specify the following automatic numbering
formats:

1.0 Chapter title Auto Number - Format
1.1 Section tifle <_(_§ Chapter headings: +.0N
111 ?ub;?mz‘s :123 (_\ Section headings: #.4\
. ¢ . .

2 thzr list ;;; (—\ Subsection headings: #.#.+\t

3. Other list item (_\ First list item: L:1N
112" Subsection tile Other list items: L+
1.2  Section title

Identify the list items as a separate number series: Type L:1.\t for
the automatic numbering format for the first list item and L:+.\t for
the automatic numbering format for the other list items. The L and
colon (:) identify the number series. When numbering these
paragraphs, FrameMaker looks only at the paragraphs in the

same numbering series.

For more information about FrameMaker’s automatic paragraph
numbering capability, see the Paragraphs command in Chapter 3 of
the FrameMaker Reference Manual.
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Creating a bulleted list
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You may often need to create bulleted lists like the ones at the
beginning and end of each chapter in this manual. While you can
type the bullet for each paragraph in the list, it is more convenient
to let FrameMaker insert the bullet for you.

We’ll change the paragraphs describing the organization of the
Civil Engineering Department into a bulleted list.

Create the tab stop

As you learned in the previous section, you need a tab stop in
order to format the list correctly.

To set the tab stop:

1. Put the insertion point in the paragraph that begins with Jane
Parmenter.

2.}  Orgenizationy
: The Civil Engineering Department consists of:{]

Jane Plarmenter, Vice-presidere
Kevin Susco, Stress Analysef

2. Put a left-aligned tab stop at the 2-1/4" position on the ruler
by clicking the left mouse button just below 2-1/4" on the ruler.

Notice that the position of the text hasn’t changed yet. It will
change after we specify the rest of the format for a bulleted list.

Create the bullet format
To create the format for the bulleted list:

1. Choose the Paragraphs command from the Format or Maker
menu.

2. In the Paragraphs dialog box, turn on the Auto Number -
Format setting.

Hyphenate - Tolerance: | 4 ]
[X] Auto Number - Format: )[ | |

Bulleted lists are created using FrameMaker’s automatic
paragraph numbering feature. Instead of using a numbering
sequence, however, you’ll tell FrameMaker to begin each
paragraph with a bullet and a tab character.

3. Press and hold down the Alt key and then type a period.
A bullet appears in the Auto Number - Format edit box.
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4. Type \t to tell FrameMaker to insert a tab character after the
bullet.

Auto Number - Format: )Lo\tl |

To change the tag of this paragraph and store the new tag in the
Catalog:

1. In the upper-left portion of the dialog box (not in the Apply To
area) replace the contents of the Tag edit box with bullet.

Left Indent:
First Line:
Right Indent:
l Tag: >| bullet| |

2. Inthe Apply To area of the Paragraphs dialog box, turn on only
the Catalog setting. Do not turn on the Tag setting; it would
apply this new format to all “body” tags.

3. Click OK.

The paragraph is now a bulleted item.

«} Jane Parmenter, Vice-presidensf
Kevin Susco, Stress Anadystf

Change the format of other paragraphs

Now you can use the new bullet format for the other items in the
list.

To apply a Catalog entry to an existing paragraph:

1. Highlight the four paragraphs below the bulleted item (down to
but not including the Primary Contacts heading).

2. Choose the Catalog command from the Format or Maker menu.

The Catalog dialog box appears.
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3. In the Catalog scroll list, click on “bullet.”

Apply to [ ok ]
@ current

e —
Al

(O update entire document
(O Delete from catalog

4. Click OK.
All four paragraphs change into bulleted items.

Add a bulleted item
Suppose that you want to add a bulleted item at the end of the list.
To add a bulleted item:

1. Put the insertion point at the end of the last bulleted item (the
line ending with Engineering Staff).

2. Press Enter.

FrameMaker inserts the bullet and tab character at the
beginning of the next paragraph.

3. Type Additional consultants, as needed

Using keyboard shortcuts

FrameMaker User’s Manual

Next we want to add some text to the proposal. In particular, we
want to add the following information after the list of primary
contacts on page 1.

4. Number of Computers Requested
Two

5. Proposed Location(s) of Computers
473 Broadway

You can easily add this text and format it correctly by using the -
Catalog that we set up in this document.

To type a new “heading” paragraph:

1. Put the insertion point at the end of the last line of the primary
contacts (the line containing Kevin Susco).

2. Press Enter to start a new paragraph.
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W

. Press Esc f ¢ (for format catalog) to display the Catalog
dialog box.

Type the lett<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>